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About this guide

This guide describes how to install, configure, and administer the BlackBerry Collaboration Service.

This guide is intended for senior and junior IT professionals who are responsible for setting up and administering the BlackBerry 
Collaboration Service and BlackBerry UEM. Before using this guide, BlackBerry UEM should be installed and configured. For 
more information on installing BlackBerry UEM, see the BlackBerry UEM Installation and upgrade content. For more 
information about configuring BlackBerry UEM, see the BlackBerry UEM Configuration content.
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What is BlackBerry Collaboration 
Service?

The BlackBerry Collaboration Service provides an encrypted connection between your organization's instant messaging server 
and the Enterprise IM app on BlackBerry 10 devices so that users can start and manage instant messaging conversations on 
their devices.
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Preinstallation checklist

Verify that the following requirements are met before you install BlackBerry Collaboration Service 12 version 12.7.

When you verify requirements in this document, download the BlackBerry Collaboration Service and BlackBerry Enterprise IM 
App Compatibility Matrix.

Minimum requirements for installing BlackBerry Collaboration Service

The following requirements apply when you install the BlackBerry Collaboration Service in your organization.

Complete Requirement

• Verify that your organization's environment is running BlackBerry UEM version 12.7.

• For information about planning your BlackBerry UEM installation, software requirements, hardware 
requirements, installation instructions, and additional tasks, see the BlackBerry UEM Installation 
and upgrade content.

• Verify that you have logged in to BlackBerry UEM for the first time.

• Verify that you have a supported instant messaging server.

• Verify that your computer is running an operating system that supports BlackBerry Collaboration 
Service 12 version 12.7.

• If you use IBM Sametime 8.5.2 or 9.0, on the computer that hosts the BlackBerry Collaboration 
Service, verify the following:

◦ The IP address of the computer that hosts the BlackBerry Collaboration Service is added 
to the Community Connectivity document on the IBM Sametime server.

◦ If your organization uses IBM Sametime with IBM Domino Directory, verify that IBM Notes 
Traveler 8.5.3 or later is installed in the environment.

• If you use Microsoft Lync Server 2010, Microsoft Lync Server 2013 or Skype for Business, on the 
computer that hosts the BlackBerry Collaboration Service, verify the following are installed:

◦ Microsoft .NET Framework 4.5

3
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Complete Requirement

◦ Microsoft Unified Communications Managed API 4.0 Runtime 64-bit, version 5.0.8308.x 
(UCMARuntimeSetup.exe)

◦ The required certificate in the Personal Certificate folder for the local computer account

For more information about certificate requirements, visit support.blackberry.com/kb to 
read article KB37126.

• Verify that the BlackBerry 10 devices are running BlackBerry 10 OS version 10.3.1 or later. To allow 
users in your environment to use the latest features available with BlackBerry Collaboration Service 
and BlackBerry Enterprise IM app version 3.3.0, verify that the BlackBerry 10 devices are running 
the required minimum BlackBerry 10 OS version.

◦ If the emoticon picker in chat windows is disabled in your organization, verify that the 
BlackBerry 10 devices are running BlackBerry 10 OS version 10.3.1 or later and 
BlackBerry Enterprise IM app version 3.3.0.

◦ If your organization uses BlackBerry Secure Connect Plus, verify that the BlackBerry 10 
devices are running BlackBerry 10 OS version 10.3.2 or later.

◦ If your organization uses Skype for Business, verify that the BlackBerry 10 devices are 
running BlackBerry 10 OS version 10.3.1 or later and BlackBerry Enterprise IM app 
version 3.2.0 or later.

◦ If the BlackBerry Collaboration Service is enabled for certificate-based authentication in 
your Microsoft Lync Server or Skype for Business environment, verify that the BlackBerry 
10 devices are running BlackBerry 10 OS version 10.3.1 or later and BlackBerry 
Enterprise IM app version 3.2.0 or later.

◦ If your organization displays disclaimers in chat windows, verify that the BlackBerry 10 
devices are running BlackBerry 10 OS version 10.3.1 or later and BlackBerry Enterprise 
IM app version 3.2.0 or later.

Other installation considerations

Supported

• Current in-market releases of VMware and Microsoft Hyper-V Server are supported with the latest BlackBerry 
Collaboration Service version. For more information, support.blackberry.com/kb to read article KB29661.

• The BlackBerry Collaboration Service supports only TLS for TCP/IP connections in a Microsoft Lync Server and Skype 
for Business environments.

• The BlackBerry Collaboration Service supports remote access by administrators who use Remote Desktop 
Connection.

Preinstallation checklist 
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Unsupported

• The BlackBerry Collaboration Service does not support installation in a DMZ.

• You cannot install BlackBerry Collaboration Service until you log in to BlackBerry UEM for the first time to register your 
SRP ID and SRP authentication key.

• In a Microsoft Lync Server and Skype for Business environment, the BlackBerry Collaboration Service that supports 
BlackBerry 10 devices cannot be installed on a computer that already hosts the BlackBerry Collaboration Service for 
BES10 or BlackBerry Collaboration Service that supports BlackBerry OS (version 5.0 to 7.1) devices.

• A BlackBerry UEM that connects to multiple instances of the BlackBerry Collaboration Service does not support more 
than one type of instant messaging server. You must use the same type of instant messaging server, such as Microsoft 
Lync Server 2010, for each local or remote BlackBerry Collaboration Service instance that you connect to BlackBerry 
UEM.

• The BlackBerry Collaboration Service does not support installation on the computer that hosts the instant messaging 
server.
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Planning a BlackBerry Collaboration 
Service installation

You can install the BlackBerry Collaboration Service on the computer that hosts BlackBerry UEM or on a separate computer. 
You should consider any effect on system resources before you decide where to install the BlackBerry Collaboration Service. If 
the environment has a mix of BES5 and BlackBerry UEM, the BES5 devices continue to use the BlackBerry Collaboration 
Service that came with BES5.

If you want to maximize the number of TCP connections available so that the BlackBerry Collaboration Service can respond to 
an increased amount of requests from the Enterprise IM app, you can install the BlackBerry Collaboration Service on a separate 
computer.

You can install multiple BlackBerry Collaboration Service instances, but you can install only one type of BlackBerry 
Collaboration Service for each BlackBerry UEM in your organization's environment. If you want to change the instant messaging 
environment (for example, from Microsoft Lync Server 2013 to Skype for Business) that an instance of the BlackBerry 
Collaboration Service uses, you must remove the existing instance of the BlackBerry Collaboration Service and select the new 
instant messaging server during the installation process.

Supported installation and upgrade paths
To upgrade BlackBerry Collaboration Service to BlackBerry Collaboration Service 12 version 12.7, you can use the following 
installation and upgrade paths:

• You can upgrade BlackBerry Collaboration Service 12 version 12.3 and later to BlackBerry Collaboration Service 12 
version 12.7 using the setup application on the computer that hosts the previous version of the BlackBerry 
Collaboration Service.

• If you change the instant messaging server (for example, from Microsoft Lync Server 2013 to Skype for Business) that 
your BlackBerry Collaboration Service instance connects to, you must remove the existing BlackBerry Collaboration 
Service instances. You can then install BlackBerry Collaboration Service 12 version 12.7.

If you have multiple instances of BlackBerry Collaboration Service in your environment, you must complete this task on each 
computer that hosts an instance of the BlackBerry Collaboration Service.

Related information
Steps to remove the BlackBerry Collaboration Service software, on page 40
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How BlackBerry Collaboration Service supports 
high availability
The BlackBerry Collaboration Service supports an active-active high availability model to minimize service interruptions for 
BlackBerry Enterprise IM app users. You can install multiple instances of the BlackBerry Collaboration Service to provide load-
balancing for authentication requests and to promote reliability.

A settings file is sent from the BlackBerry UEM environment to the BlackBerry Enterprise IM app when the BlackBerry 10 
device is activated. The settings file contains a list of the BlackBerry Collaboration Service instances that are available in your 
environment. When a device user logs in to the BlackBerry Enterprise IM app, the app connects to one of the instances of the 
BlackBerry Collaboration Service included in the settings file. If an instance of the BlackBerry Collaboration Service becomes 
unavailable, the BlackBerry Enterprise IM app automatically tries to connect to the next available BlackBerry Collaboration 
Service instance.

For disaster recovery, such as if your instant messaging server pool is not available and a new instant messaging server pool is 
created, you must manually change the instant messaging server pool that the BlackBerry Collaboration Service connects to.

Related information
Change the instant messaging server pool that the BlackBerry Collaboration Service connects to, on page 35
Sending updated device settings to BlackBerry 10 devices, on page 28
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Requirements

Hardware requirements: BlackBerry 
Collaboration Service
The following requirements apply to the computer that you install the BlackBerry Collaboration Service on. For more information 
about calculating hardware requirements, see the BlackBerry UEM Installation and upgrade content.

Item Description

Hardware requirements • One processor, Quad Core, 2.4 GHz (4 cores) or 4 vCPU

• 6 GB of available memory (for 1000 users or fewer)

• 100 GB of disk space

• Supports up to 5000 devices for each BlackBerry Collaboration Service 
instance, per computer

• Install an additional 1 GB of memory for each 1000 users beyond the first 
1000

• Less memory might be required for 1000 users if the Java memory footprint is 
reduced. For instructions, visit support.blackberry.com/kb to read article 
KB34951.

• Additional memory might be required if users have a higher number of active 
conversations than is typical

Software requirements: BlackBerry Collaboration 
Service
The following requirements apply to your organization or the computer that you install the BlackBerry Collaboration Service on.

Item Requirement

BlackBerry UEM Verify that your organization is running BlackBerry UEM version 12.7.

5
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Item Requirement

Operating system Verify that your computer is running an operating system that supports BlackBerry 
Collaboration Service 12 version 12.7.

For more information about the supported operating systems, download the 
BlackBerry Collaboration Service and BlackBerry Enterprise IM App Compatibility 
matrix

Device software • BlackBerry 10 OS version 10.2.1 or later. To allow users in your environment 
to use the latest features available with BlackBerry Collaboration Service 12 
version 12.7 and BlackBerry Enterprise IM app version 3.3.0, verify that the 
BlackBerry 10 devices are running the required minimum BlackBerry 10 OS 
version.

◦ If the emoticon picker in chat windows is disabled in your 
organization, verify that the BlackBerry 10 devices are running 
BlackBerry 10 OS version 10.3.1 or later and BlackBerry Enterprise 
IM app version 3.3.0.

◦ If your organization uses BlackBerry Secure Connect Plus, verify 
that the BlackBerry 10 devices are running BlackBerry 10 OS 
version 10.3.2 or later.

◦ If your organization uses Skype for Business, verify that the 
BlackBerry 10 devices are running BlackBerry 10 OS version 10.3.1 
or later and BlackBerry Enterprise IM app version 3.2.0 or later.

◦ If the BlackBerry Collaboration Service is enabled for certificate-
based authentication in your Microsoft Lync Server or Skype for 
Business environment, verify that the BlackBerry 10 devices are 
running BlackBerry 10 OS version 10.3.1 or later and BlackBerry 
Enterprise IM app version 3.2.0 or later.

◦ If your organization displays disclaimers in chat windows, verify that 
the BlackBerry 10 devices are running BlackBerry 10 OS version 
10.3.1 or later and BlackBerry Enterprise IM app version 3.2.0 or 
later.

IBM Sametime • IP address of the computer that hosts the BlackBerry Collaboration Service 
added to the Community Connectivity document on the IBM Sametime server

• If your organization uses IBM Sametime with the IBM Domino Directory, IBM 
Notes Traveler 8.5.3 or later must be installed to perform remote searches 
using the Enterprise IM app.

Requirements
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Item Requirement

Microsoft Lync Server 2010, Microsoft 
Lync Server 2013, and Skype for 
Business

• Microsoft .NET Framework 4.5

• Microsoft Unified Communications Managed API 4.0 Core Redistributable 64-
bit (UCMARuntimeSetup.exe)

• The required certificate installed in the Personal Certificate folder for the local 
computer account

For more information about the Microsoft installation packages and installing the 
required certificate, see "Preparing the computer that hosts the BlackBerry 
Collaboration Service for use with Microsoft Lync Server 2010, Microsoft Lync 
Server 2013, or Skype for Business."

Related information
Preparing the computer that hosts the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010, Microsoft 
Lync Server 2013, or Skype for Business, on page 18

Software requirements: Instant messaging server
Any of the following on-premise instant messaging servers:

• IBM Sametime 8.5.2 (Limited support)

• IBM Sametime 9.0

• Microsoft Lync Server 2010

• Microsoft Lync Server 2013

• Skype for Business

Supported features and environments
Item Description

Virtual environment Current in-market releases of VMware and Microsoft Hyper-V are supported with 
the latest BlackBerry Collaboration Service version. For more information, visit 
support.blackberry.com/kb to read article KB29661.

IP The BlackBerry Collaboration Service supports only IPv4 and TLS for TCP/IP 
connections.

Requirements
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Item Description

Remote access The BlackBerry Collaboration Service supports remote access by administrators 
who use Remote Desktop Connection.

Unsupported environments
Item Description

DMZ The BlackBerry Collaboration Service does not support installation in a DMZ.

Installation You cannot install BlackBerry Collaboration Service until you log in to BlackBerry UEM for 
the first time to register your SRP ID and SRP authentication key.

Computer that hosts the 
BlackBerry Collaboration Service

In a Microsoft Lync Server or Skype for Business environment, the BlackBerry 
Collaboration Service that supports BlackBerry 10 devices cannot be installed on a 
computer that already hosts the BlackBerry Collaboration Service for BES10 or the 
BlackBerry Collaboration Service that supports BlackBerry OS (version 5.0 to 7.1) 
devices.

Instant messaging server • A BlackBerry UEM instance that connects to multiple instances of the BlackBerry 
Collaboration Service does not support more than one type of instant messaging 
server. You must use the same type of instant messaging server, such as Microsoft 
Lync Server 2010, for each local or remote BlackBerry Collaboration Service 
instance that you connect to BlackBerry UEM.

• The BlackBerry Collaboration Service does not support installation on the computer 
that hosts the instant messaging server.

Requirements
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Preinstallation tasks

Configure permissions for the service account
The service account is a Windows account that runs the services for the BlackBerry Collaboration Service. On the computer that 
you want to install the BlackBerry Collaboration Service on, you must configure permissions for the service account. Without the 
correct permissions, the BlackBerry Collaboration Service cannot run.

You can use the BlackBerry UEM service account to install the BlackBerry Collaboration Service.

Before you begin: If you do not use the BlackBerry UEM service account in Microsoft Active Directory, create a service account 
that you name BCSAdmin.

1. On the taskbar, click Start > Administrative Tools > Computer Management.

2. In the left pane, expand Local Users and Groups.

3. Navigate to the Groups folder.

4. In the right pane, double-click Administrators.

5. Click Add.

6. In the Enter the object names to select field, type the name of the service account (for example, BCSAdmin).

7. Click OK.

8. Click Apply.

9. Click OK.

10. On the taskbar, click Start > Administrative Tools > Local Security Policy.

11. In the left pane, expand Local policies.

12. Click User rights agreement.

13. Configure the following permissions for the service account:

• Allow log on locally (if not assigned by default)

• Log on as a service

5
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Verifying database permissions to connect to the 
BlackBerry Collaboration Service
The BlackBerry Collaboration Service connects to the BlackBerry UEM database using the service account that you use to 
complete the installation process or the Microsoft SQL Server account that you specify during the installation process. The 
setup application might need to update the BlackBerry UEM database during the installation process, so the service account or 
Microsoft SQL Server account must have permissions on the server to update the BlackBerry UEM database.

You can configure database permissions using Microsoft SQL Server roles. You must verify that the service account or Microsoft 
SQL Server account is a member of the db_owner database role for the BlackBerry UEM database.

Preparing the computer that hosts the 
BlackBerry Collaboration Service for use with 
Microsoft Lync Server 2010, Microsoft Lync 
Server 2013, or Skype for Business
If you plan to install the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010 or 2013 or Skype for 
Business, you must verify that the computer that you install the BlackBerry Collaboration Service on meets specific 
requirements.

Before you install the BlackBerry Collaboration Service, you must perform the following actions in the order that they are listed:

1. Install and enable Microsoft .NET Framework 4.5 or 4.6.

• On a computer that is running Windows Server 2012 or Windows Server 2016, use the Windows Server Manager 
to add Microsoft .NET Framework as a feature. When the installation prompts you to restart the computer, click 
Yes.

• On a computer that is running Windows Server 2008, complete the following steps:

1. Download Microsoft .NET Framework 4.5. To download the file, visit www.microsoft.com/downloads.

2. Double-click dotNetFx45_Full_setup.exe. Complete the instructions on the screen.

2. Complete one of the following tasks using Windows Server Manager:

• If you install the BlackBerry Collaboration Service on a computer that is running Windows Server 2008, install 
Desktop Experience. When the installation prompts you to restart the computer, click Yes.

• If you install the BlackBerry Collaboration Service on a computer that is running Windows Server 2012, install 
Media Foundation. When the installation prompts you to restart the computer, click Yes.

Preinstallation tasks
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3. Download Microsoft Unified Communications Managed API 4.0 Runtime 64-bit, version 5.0.8308.x 
(UcmaRuntimeSetup.exe). To download the file, visit www.microsoft.com/downloads and search for ID=34992.

a Install UcmaRuntimeSetup.exe.

Optionally, you can remove the following components using the Programs and Features program:

• Microsoft Server Speech Platform Runtime (x64)

• Microsoft Server Speech Recognition Language - TELE (en-US)

• Microsoft Server Speech Text to Speech Voice (en-US, Helen)

• Microsoft Speech Platform VXML Runtime (x64)

4. Install the required certificate in the Personal Certificate folder for the local computer account.

For more information about certificate requirements, visit support.blackberry.com/kb to read article KB37126.

Related information
Create a Personal Certificate for the local computer account for the BlackBerry Collaboration Service, on page 21

Provisioning the BlackBerry Collaboration 
Service as a trusted application
If you install Microsoft Lync Server 2010, Microsoft Lync Server 2013, or Skype for Business for instant messaging, you must 
manually provision the BlackBerry Collaboration Service as a trusted application in Microsoft Active Directory. For more 
information about using manual provisioning in your environment, visit support.blackberry.com/kb to read article KB28474.

If your organization's environment includes multiple instances of the BlackBerry Collaboration Service, you must provision each 
instance as a trusted application. If you change the listening port number or if the FQDN of the instant-messaging pool changes, 
you must repeat the provisioning task.

Manually provision the BlackBerry Collaboration Service as a 
trusted application using Lync PowerShell
Before you begin: 

• Verify that the account that you use to complete this task is a member of the RTCUniversalServerAdmins group.

• For more information about manually provisioning the BlackBerry Collaboration Service as a trusted application, visit 
support.blackberry.com/kb to read article KB28474.

1. Log in to the computer that hosts the Microsoft Lync Server 2010, Microsoft Lync Server 2013, or Skype for Business 
using an account with RTCUniversalServerAdmins group permissions.

2. Open a Lync PowerShell window and confirm if a trusted application pool exists. Complete the following steps:

Preinstallation tasks
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a. To verify if a virtual application pool exists for the BlackBerry Collaboration Service, type Get-
CsTrustedApplicationPool | Where-Object {$_.Applications -like "*rimmsconnector*"}. Press Enter. If a pool exists, 
continue to step 3e.

3. On the computer that hosts the Microsoft Lync Server 2010, Microsoft Lync Server 2013, or Skype for Business, create 
the trusted application pool.

a. To obtain the SiteID of your Microsoft Lync Server, type Get-CsSite. Press Enter. Record the SiteID.

b. To display the Registrar service value for a selected site, type Get-CsSite <SiteId> | Select-Object -ExpandProperty 
Services. Press Enter. Record the Registrar service value.

c. To configure the trusted application entry for the newly created trusted application pool for the BlackBerry 
Collaboration Service, type New-CsTrustedApplicationPool -Identity <YourPoolFQDN> -Registrar 
Registrar:<FQDNRegistrarService> -Site <SiteID> -ComputerFQDN <BlackBerryCollaborationServiceFQDN> -
ThrottleAsServer $true -TreatAsAuthenticated $true -RequiresReplication $false. Press Enter.

• Where YourPoolFQDN is the FQDN of the virtual Application pool of the BlackBerry Collaboration Service 
instances.

• Where SiteID is the SiteID that was recorded in step 3a.

• Where FQDNRegistrarService is the value recorded in step 3b.

• Where BlackBerryCollaborationServiceFQDN is the FQDN of the BlackBerry Collaboration Service.

d. To create a trusted application entry, type New-CsTrustedApplication -ApplicationId RIMMSConnector -
TrustedApplicationPoolFqdn <YourPoolFQDN> -Port <BlackBerryCollaborationServiceListenPort>. Press Enter.

Where BlackBerryCollaborationServiceListenPort is the port on which the BlackBerry Collaboration Service listens for 
response from the Microsoft Lync Server. The default port number is 65061.

e. If your organization's environment has multiple instances of the BlackBerry Collaboration Service, add the FQDNs of 
the additional instances to your application pool. Type New-CsTrustedApplicationComputer -Identity 
<BlackBerryCollaborationServiceFQDN> -Pool <YourPoolFQDN>. Press Enter.

f. Repeat step 3e for each BlackBerry Collaboration Service instance in your organization's network.

g. To publish the change to the Microsoft Lync Server environment, type Enable-CsTopology. Press Enter.

4. On the computer that hosts the Microsoft Lync Server 2010, Microsoft Lync Server 2013, or Skype for Business, obtain the 
GRUU for the TrustedApplication.

a. To list the trusted application pools in your environment, type Get-CsTrustedApplicationPool. Press Enter.

b. To list the Computer GRUUs within a specific pool, type $a = Get-CsTrustedApplication -Identity "<YourPoolFQDN>/
urn:application:rimmsconnector". Press Enter.

To view the FQDN and GRUU for each computer, type $a.ComputerGruus | fl

The following is an example of a ComputerGRUU: 
sip:<BlackBerryCollaborationServiceFQDN>@<domain_name>;gruu;opaque=srvr:rimmsconnector:<characters>

Preinstallation tasks
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c. Record the FQDN and GRUU for each computer in the pool.

5. If the BlackBerry Collaboration Service is installed, complete the following steps on the computer that hosts the 
BlackBerry Collaboration Service:

a. Navigate to <drive>:\Program Files\BlackBerry\BlackBerry Collaboration Service\BBIM\Servers\instance\config.

b. In a text editor (run as administrator), open the rimpublic.property file.

c. At the end of the file, type 
improxy.gruu=sip:<BlackBerryCollaborationServiceFQDN>@<domain_name>;gruu;opaque=srvr:rimmsconnector:
<characters> as recorded in step 4c.

d. Save and close the rimpublic.property file.

e. In Windows services, restart the BlackBerry Collaboration Service.

f. Verify that the GRUU is logged in the BBIM log files. Search for the term gruu.

g. Repeat steps a to f for each BlackBerry Collaboration Service instance.

Create a Personal Certificate for the local 
computer account for the BlackBerry 
Collaboration Service
1. Open the Microsoft Management Console.

2. Click Console Root.

3. Click File > Add/Remove Snap-in.

4. In the Available snap-ins list, click Certificates. Click Add.

5. In the Certificates snap-in dialog, select the Computer account option. Click Next.

6. In the Select Computer dialog, select the Local computer option. Click Finish.

7. Click OK.

8. Expand Certificates (Local Computer) > Personal.

9. Right-click Certificates. Click All Tasks > Request New Certificate.

10. In the Certificate Import Wizard, click Next.

11. Click Active Directory Enrollment Policy, and click Next.

12. Perform one of the following tasks:

Preinstallation tasks
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Environment Steps

Skype for Business 1. Select an appropriate web server template from the available templates.

a Click Details to verify that the Server Authentication is displayed in 
the Application Policies section.

b In the Application policies section, verify that Server Authentication 
is listed. If Server Authentication is not listed, select a different web 
server template. Contact your CA administrator for more information 
about templates.

2. Click More information is required to enroll for this certificate. Click here 
to configure settings.

3. On the Subject tab, in the Subject name section,

• Click the Type drop-down list. Select Common name.

• In the Value field, type the FQDN of the computer that hosts the 
BlackBerry Collaboration Service

• Click Add >.

4. In the Alternative name section,

• Click the Type drop-down list. Select DNS.

• In the Value field, type the FQDN of the computer that hosts the 
BlackBerry Collaboration Service.

• Click Add >.

• In the Value field, type the BlackBerry Collaboration Service 
Trusted Pool FQDN as was recorded in step 4c of Manually 
provision the BlackBerry Collaboration Service as a trusted 
application using Lync PowerShell.

• Click Add >.

• Click Apply.

• Click OK.

• Click Enroll.

Microsoft Lync Server 2010 or 
Microsoft Lync Server 2013

1. Select an appropriate computer template from the available templates.

a Click Details to verify that the Server Authentication is displayed in 
the Application Policies section.

b In the Application policies section, verify that Server Authentication 
is listed. If Server Authentication is not list, select a template that 
includes Server Authentication. Contact your CA administrator for 
more information about templates.
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Environment Steps

2. Click Enroll.

3. Click Finish.

13. Click Apply.

After you finish: For more information about certificate requirements, visit support.blackberry.com/kb to read article KB37126.

Related information
Manually provision the BlackBerry Collaboration Service as a trusted application using Lync PowerShell, on page 19
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Prerequisites: Installing the 
BlackBerry Collaboration Service 
software

Verify that you have the following system information available:

• For the BlackBerry UEM database: the database name, the database server name, and if the database server uses 
static ports, the port number.

• For the instant messaging server: the port number and either the host name of the instant messaging server or the 
FQDN of the instant messaging pool.

Accessing the BlackBerry Collaboration Service 
software
You can open the BlackBerry Collaboration Service software folder in the BlackBerry UEM version 12.7 installation files located 
at <drive>:\BlackBerry\BlackBerry Collaboration Service <version>\bundle <bundle number>\ and run the executable, or 
complete the following steps:

1. In a browser, navigate to docs.blackberry.com/enterprise-im.

2. In the To view software for a BlackBerry product, please select a product from the drop down menu list, click 
BlackBerry Collaboration Service.

3. Click Next.

4. Select the BlackBerry Collaboration Service software file to download.

5
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Installing the BlackBerry 
Collaboration Service software

Install the BlackBerry Collaboration Service
During the installation process, you might need to restart the computer.

Before you begin: 

• Verify that the service account has local administrator permissions on the computer that you install the BlackBerry 
Collaboration Service on.

• Verify that the computer that you install the BlackBerry Collaboration Service on has the required software and 
prerequisite files, and certificates are installed.

1. Log in to the computer that you want to install the BlackBerry Collaboration Service on using the service account that has 
correct permissions. The service account runs the BlackBerry Collaboration Service services.

2. In the BlackBerry Collaboration Service installation files located at <drive>:\BlackBerry\BlackBerry UEM <version 
number>\bcs, extract the zipped installation files.

3. In the extracted BlackBerry Collaboration Service software files (<drive>:\BlackBerry\BlackBerry Collaboration Service 
<version number>\bundle<bundle number>), double-click Setup.exe. If a Windows message appears and requests 
permission for Setup.exe to make changes to the computer, click Yes.

4. In the License agreement dialog box, perform the following actions:

a. In the Customer information section, specify information for your organization and select your country or region. The 
setup application uses the organization name that you specify when it creates the certificate for the BlackBerry 
Collaboration Service.

b. In the License agreement section, read the license agreement. To accept the license agreement, select I accept the 
terms of the license agreement.

c. Click Next.

5. In the Database information dialog box, specify information for the Microsoft SQL Server name and database that 
BlackBerry UEM uses. Click Next.

6. In the Instant messaging settings dialog box, perform the following actions:

a. In the Instant messaging server drop-down list, select the instant messaging server that is in your organization's 
environment.

b. In the BlackBerry Collaboration Service port field, change the port number if necessary. By default, the BlackBerry 
Collaboration Service uses port 8181 to listen for connections from the Enterprise IM app.

6
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c. If applicable, in the Host field, type the host name of the instant messaging server.

d. In the Port field, type the port number of the instant messaging server.

e. If applicable, in the Pool name field, type the FQDN of the instant messaging pool.

f. Click Next.

7. In the Preinstallation checklist dialog box, read and verify the information. Click Next.

8. In the Accounts and folders dialog box, perform the following actions:

a. In the Password field, type the password for the service account that you used in step 1.

b. If necessary, change the location of the installation folder and log-file folder.

c. Click Next.

9. In the Summary dialog box, verify that the information is correct. Click Install.

10. If the BlackBerry Collaboration Service is not provisioned as a trusted application and a personal certificate for the local 
computer account is not created, in the Finalize installation dialog box, verify the Start the BlackBerry Collaboration 
Service check box is cleared and click Finish.

After you finish: 

• If necessary, provision the BlackBerry Collaboration Service as a trusted application.

• If necessary, create a personal certificate for the local computer account for the BlackBerry Collaboration Service.

• To check if the BlackBerry Collaboration Service is installed, you can check the following:

◦ The collaboration settings are displayed in the management console at Settings > Collaboration on the 
Settings and Device settings tabs.

◦ The BlackBerry Collaboration Service appears in the Services list.

• If necessary, in Windows Services, start the BlackBerry Collaboration Service.

Related information
Manually provision the BlackBerry Collaboration Service as a trusted application using Lync PowerShell, on page 19
Create a Personal Certificate for the local computer account for the BlackBerry Collaboration Service, on page 21
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Postinstallation tasks

Add the GRUU string to the rimpublic.property 
file
1. Log in to the computer that hosts the BlackBerry Collaboration Service as an administrator.

2. Navigate to <drive>:\Program Files\BlackBerry\BlackBerry Collaboration Service\BBIM\Servers\instance\config.

3. In a text editor, open the rimpublic.property file.

4. At the end of the file, type 
improxy.gruu=sip:<BlackBerryCollaborationServiceFQDN>@<domain_name>;gruu;opaque=srvr:rimmsconnector:<cha
racters> as recorded in step 4c of Manually provision the BlackBerry Collaboration Service as a trusted application using 
Lync PowerShell.

5. Save and close the rimpublic.property file.

6. In Windows services, restart the BlackBerry Collaboration Service.

7. Verify that the GRUU is logged in the BBIM log files. Search for the term gruu.

8. Repeat steps 1 to 7 for each BlackBerry Collaboration Service instance.

Start the BlackBerry Collaboration Service 
service
1. On the computer that hosts the BlackBerry Collaboration Service, on the taskbar, click Start > Administrative Tools > 

Services.

2. In the Services (local) pane, right-click BlackBerry UEM - BlackBerry Collaboration Service. Click Start.

6
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View the status of BlackBerry Collaboration 
Service instances
You can view the status of each BlackBerry Collaboration Service instance in your domain.

1. In the management console, on the menu bar, click Settings.

2. In the left pane, click Infrastructure > Instances.

For each BlackBerry Collaboration Service instance in the domain, you can view the following information:

• The status of each BlackBerry Collaboration Service instance (running or stopped)

• The version of the BlackBerry Collaboration Service instance

3. To refresh the information on the page, click .

Accessing the BlackBerry Enterprise IM app for 
BlackBerry 10 devices
1. In a browser, navigate to docs.blackberry.com/enterprise-im.

2. In the To view software for a BlackBerry product, please select a product from the drop down menu list, click 
BlackBerry Enterprise IM for Microsoft Lync, IBM Sametime v3 for BlackBerry 10 devices.

3. Click Next.

4. Download the latest version of the BlackBerry Enterprise IM app.

After you finish: For information about making apps available on devices, see the BlackBerry UEM Administration content.

Additional information

Sending updated device settings to BlackBerry 10 devices
You can add and remove BlackBerry Collaboration Service instances in your organization's environment. After you add or 
remove an instance, an updated device settings file must be sent to BlackBerry 10 devices. The device settings file provides 
BlackBerry 10 devices with information about available BlackBerry Collaboration Service instances in your organization's 
environment.
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Update the device settings when BlackBerry Collaboration Service instances are added 
and removed
When you add or remove BlackBerry Collaboration Service instances in your organization's environment, you must send the 
updated information to BlackBerry 10 devices.

1. In the management console, on the menu bar, click Settings.

2. In the left pane, click Collaboration > Device settings.

3. Click Update device settings.

Related information
Enable certificate-based authentication mode, on page 30

Enabling certificate-based authentication mode
The BlackBerry Collaboration Service can use one of the following two authentication modes in the environment:

• Certificate-based

• Username and password

By default, the BlackBerry Collaboration Service uses the BlackBerry 10 device user's username and password to log in to the 
BlackBerry Enterprise IM app.

You can enable certificate-based authentication in your environment for devices that are running BlackBerry 10 OS version 
10.3.1 or later and use the BlackBerry Enterprise IM app version 3.2.0 or later to log in to the instant messaging server. If 
certificate-based authentication is enabled, only BlackBerry 10 devices using BlackBerry Enterprise IM apps that support 
certificate-based authentication can authenticate with the BlackBerry Collaboration Service. Enabling certificate-based 
authentication disables the username and password authentication mode.

Steps to set up certificate-based authentication
When you set up certificate-based authentication, you perform the following actions:

Step Action

Create a single sign-on profile to configure how BlackBerry 10 devices authenticate with the BlackBerry 
Collaboration Service instances in your environment.

If necessary, rank profiles.

Assign profiles to user accounts or user groups.
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Step Action

Enable the BlackBerry Collaboration Service for certificate-based authentication.

Related information
Enable certificate-based authentication mode, on page 30
Create a single sign-on profile to authenticate with the BlackBerry Collaboration Service, on page 30

Setting up single sign-on authentication for BlackBerry 10 devices
Using a single sign-on profile, you can enable BlackBerry 10 devices to authenticate automatically with domains and the 
BlackBerry Collaboration Service instances in your organization’s network. After you assign a single sign-on profile, the user is 
prompted for a username and password the first time they try to access a secure domain that you specified. The login 
information is saved on the user’s device and used automatically when the user tries to access any of the secure domains 
specified in the profile. When the user changes the password, the user is prompted the next time they try to access a secure 
domain.

Related information
Create a single sign-on profile to authenticate with the BlackBerry Collaboration Service, on page 30

Create a single sign-on profile to authenticate with the BlackBerry Collaboration Service
1. In the management console, on the menu bar, click Policies and Profiles.

2. Click  beside Single sign-on.

3. Type a name and description for the profile.

4. Click the BlackBerry tab.

5. Under Trusted domains, click .

6. In the Name field, type a name for the configuration. For example, All BlackBerry Collaboration Service instances.

7. In the Domain field, type a trusted subdomain or domain using wildcards. For example, *.example.com or 
*.<subdomain>.example.com.

8. Click Add.

After you finish: If you create more than one single sign-on profile, rank the profiles. For more information about ranking 
profiles, see the BlackBerry UEM Administration content.

Enable certificate-based authentication mode
Before you begin: 

By default, certificate-based authentication mode is turned off.
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1. On the computer that hosts the BlackBerry Collaboration Service, navigate to <drive>:\Program Files\BlackBerry
\BlackBerry Collaboration Service\BBIM\Servers\instance\config.

2. In a text editor (run as administrator), open the rimpublic.property file.

3. At the end of the file, type improxy.eimserver.cba=true.

4. Save and close the rimpublic.property file.

5. In Windows services, restart the BlackBerry Collaboration Service instance.

6. Send an updated device settings file to the BlackBerry 10 devices using the mangement console.

After you finish: 

• If you have multiple instances of BlackBerry Collaboration Service, complete steps 1-5 on each computer that hosts 
an instance of the BlackBerry Collaboration Service.

• To turn off certificate-based authentication, remove the improxy.eimserver.cba=true property or set the command to 
false.

Related information
Update the device settings when BlackBerry Collaboration Service instances are added and removed, on page 29

Displaying a disclaimer in BlackBerry Enterprise IM one-on-one 
and multiparty chats
You can configure a disclaimer to display whenever a user creates or receives a new incoming BlackBerry Enterprise IM one-on-
one and multiparty chat. The BlackBerry Collaboration Service sends the disclaimer text to the user's device when the user logs 
in to the BlackBerry Enterprise IM app. When you have configured the disclaimer, it appears at the top of the chat window on 
BlackBerry 10 devices that have the BlackBerry Enterprise IM app version 3.2.0 or later installed.

When you configure the disclaimer file, make sure that it meets the following requirements:

• Less than 1024 bytes or 256 UTF-8 characters.

• Optionally, UTF-8 encoded.

• Named disclaimer.txt. The file name is not case-sensitive.

• Saved to <drive>:\Program Files\BlackBerry\BlackBerry Collaboration Service\BBIM\Servers\instance\config on each 
computer that hosts the BlackBerry Collaboration Service.

When the disclaimer.txt file is configured, the BBIM log files log that the disclaimer is created. If the disclaimer.txt file is larger 
than 1024 bytes or empty, the BBIM log files log the error message that the disclaimer.txt file is not being used because it is too 
large or zero bytes.

Display a disclaimer in BlackBerry Enterprise IM one-on-one and multiparty chats
1. Create a text file. If necessary, create the text file using administrator permissions.
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2. Type your disclaimer message.

3. Click File > Save as.

4. Navigate to <drive>:\Program Files\BlackBerry\BlackBerry Collaboration Service\BBIM\Servers\instance\config. Click 
Save.

5. In Windows Services, restart the BlackBerry Collaboration Service.

After you finish: 

• If you have multiple instances of BlackBerry Collaboration Service, complete these steps on each computer that hosts 
an instance of the BlackBerry Collaboration Service.

• To turn off the disclaimer message, delete or rename the .txt file. In Windows Services, restart the BlackBerry 
Collaboration Service.

Emoticons in Skype for Business
Skype for Business provides emoticons that can be used in instant messaging conversations with other Skype for Business 
users. Users can use short cuts or select an emoticon from an emoticon selector to send to a contact in a chat. Sending an 
emoticon to another user results in emoticons displaying in one of the following ways:

• If both contacts are in a Skype for Business environment and the BlackBerry 10 devices are running BlackBerry 10 OS 
version 10.3.1 or later and BlackBerry Enterprise IM app version 3.2.0 or later, the emoticon is displayed in the 
recipient's chat window.

• If one of the contacts is in a Microsoft Lync Server 2010 or Microsoft Lync Server 2013 environment, that contact 
receives a text shortcut for the emoticon that is not available in their emoticon set.

Disable the emoticon picker in Microsoft Lync Server 2010, Microsoft Lync Server 2013, or 
Skype for Business
You can disable the emoticon picker for users in your organization. Disabling the emoticon picker provides users with a larger 
chat message field.

Before you begin: Verify that the BlackBerry 10 devices are running BlackBerry 10 OS version 10.3.1 or later and BlackBerry 
Enterprise IM app version 3.3.0.

1. Log in to the computer that hosts the BlackBerry Collaboration Service as an administrator.

2. Navigate to <drive>:\Program Files\BlackBerry\BlackBerry Collaboration Service\BBIM\Servers\instance\config.

3. In a text editor, open the rimpublic.property file.

4. At the end of the file, type improxy.eimserver.hideemoticon=true.

5. Save and close the rimpublic.property file.

6. In Windows services, restart the BlackBerry Collaboration Service instance.
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7. Send an updated device settings file to the BlackBerry 10 devices.

After you finish: 

• If you have multiple instances of BlackBerry Collaboration Service, complete these steps on each computer that hosts 
an instance of the BlackBerry Collaboration Service.

• To display the emoticon picker, remove the improxy.eimserver.hideemoticon=true property, comment it out, or set 
the command to false.

Turn off avatar and contact synchronization for BlackBerry 
Enterprise IM app users using IBM Sametime
When users log in to the BlackBerry Enterprise IM app, the app initiates synchronization of the address book entries and 
avatars. Users with many contacts might experience intermittent connections during the synchronization process.

When you turn off avatar and contact synchronization for the BlackBerry Enterprise IM app, the address book is not 
synchronized with the BlackBerry Enterprise IM app. Users will not be able to press the Call or Email button to contact other 
users because this information is not synchronized.

1. On the computer that hosts the BlackBerry Collaboration Service, navigate to <drive>:\Program Files\BlackBerry
\BlackBerry Collaboration Service\BBIM\Servers\instance\config.

2. In a text editor (run as administrator), open the rimpublic.property file.

3. At the end of the file, complete one of the following:

• To turn off synchronization of avatars with the BlackBerry Enterprise IM app, type improxy.avatar.sync=false.

• To turn off address book synchronization with the BlackBerry Enterprise IM app, type 
improxy.addressbook.sync=false.

4. Save and close the rimpublic.property file.

5. In Windows services, restart the BlackBerry Collaboration Service.
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Configuring the BlackBerry 
Collaboration Service

Specify the inactivity timeout limit for instant 
messaging sessions
The BlackBerry Collaboration Service closes instant messaging sessions that exceed the inactivity timeout limit. The minimum 
value is 1200000 ms.

1. In the management console, on the menu bar, click Settings > Collaboration.

2. In the left pane, click Device settings.

3. In the Inactivity timeout (milliseconds) field, type a value, in milliseconds.

4. Click Save.

Specify the maximum number of instant 
messaging sessions that can be open at the 
same time
To control bandwidth and resource consumption in your organization's environment, you can specify the number of instant 
messaging sessions that can be open between the BlackBerry Collaboration Service and the instant messaging server at the 
same time. By default, the maximum number of instant messaging sessions that can be open at the same time is 5000.

1. In the management console, on the menu bar, click Settings > Collaboration.

2. In the left pane, click Device settings.

3. In the Maximum simultaneous sessions field, type the maximum number of instant messaging sessions that can be open 
at the same time.

4. Click Save.
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Change the instant messaging server pool that 
the BlackBerry Collaboration Service connects to
You might need to change the instant messaging server pool that the BlackBerry Collaboration Service connects to in the 
following scenarios:

• You entered an incorrect server pool name during the BlackBerry Collaboration Service installation

• For disaster recovery, you need to point to a new Microsoft Lync Server server pool

Make sure that you have a valid certificate. For more information about installing a certificate, see Preparing the computer that 
hosts the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010, Microsoft Lync Server 2013, or Skype for 
Business.

If you change the IM listening port, you must manually provision the BlackBerry Collaboration Service as a trusted application. 
For more information about manually provisioning the BlackBerry Collaboration Service, see Manually provision the BlackBerry 
Collaboration Service as a trusted application using Lync PowerShell.

1. In the management console, on the menu bar, click Settings > Collaboration.

2. In the left pane, click Device settings.

3. In the IM server pool name field, type the FQDN of the pool of instant messaging servers.

4. In the IM server port field, type the port number of the instant messaging server or the port number of the pool of instant 
messaging servers.

5. If necessary, in the Listening port field, type the inbound listening port that the BlackBerry Collaboration Service uses.

6. Click Save.

7. In Windows services, restart the BlackBerry Collaboration Service instance. If you have multiple instances of BlackBerry 
Collaboration Service, restart the BlackBerry Collaboration Service on each computer that hosts an instance of the 
BlackBerry Collaboration Service.

Related information
Preparing the computer that hosts the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010, Microsoft 
Lync Server 2013, or Skype for Business, on page 18
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BlackBerry Collaboration Service connection 
types and port numbers
Item Connection type Default port number UI where you can 

configure the 
connection

Outgoing data connections to Microsoft Lync Server 
2010, Microsoft Lync Server 2013, or Skype for 
Business

TCP (TLS or MTLS) 5061 management console

Outgoing data connections to Microsoft Active Directory 
for BlackBerry Collaboration Service in Microsoft Lync 
Server 2010, Microsoft Lync Server 2013, or Skype for 
Business environments

TCP 389, 3268

Incoming data connections from the Microsoft Lync 
Server 2010, Microsoft Lync Server 2013, or Skype for 
Business

TCP (TLS or MTLS) 65061 management console

Incoming data connections from, and outgoing data 
connections to, IBM Sametime

TCP/IP 1516 management console

Incoming data connections from the Enterprise IM app TLS/HTTPS 8181

Incoming data connections from, and outgoing data 
connections to, the BlackBerry UEM database that a 
Microsoft SQL Server hosts

TCP 1433 (for static port) Windows registry

On a 64-bit version of 
Windows: 
HKEY_LOCAL_MAC
HINE\SOFTWARE
\WOW6432Node
\Research In Motion
\BlackBerry 
Enterprise Service
\Database\Port

Incoming data connections from instances of 
BlackBerry UEM to query the BlackBerry Collaboration 
Service status

TLS/HTTPS 8182
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About the BBIM log files
You can use the BBIM log files to identify and troubleshoot issues with the BlackBerry Collaboration Service or BlackBerry 10 
devices that use instant messaging in your organization's environment. The BBIM logging capabilities allow you to:

• Track the activity of the BlackBerry Collaboration Service instance

• Track device statistics such as number of logins, unsuccessful logins, and chats

BBIM logging is set at the global level. When you enable BBIM logging in the management console, BBIM logging is turned on 
for all instances of the BlackBerry Collaboration Service in your organization’s environment. The BBIM log file is created and is 
stored daily. If you install multiple BlackBerry Collaboration Service instances in your organization, each instance creates and 
stores its own log files.

By default, name of the log file is <server_name>_<log_type>_01_<yyyymmdd>_<log_number>.<file extension> (for example, 
EIMServer_BBIM_01_20150303_0001.txt).

Additional log files are created when you install the BlackBerry Collaboration Service. By default, these log files are stored in C:
\Program Files\BlackBerry\BlackBerry Collaboration Service\Logs\Installer on each computer that an instance of the BlackBerry 
Collaboration Service is installed on.

Turn on BBIM logging
When you enable BBIM logging in the management console, BBIM logging is turned on for all instances of the BlackBerry 
Collaboration Service in your organization’s environment.

1. In the management console, on the menu bar, click Settings > Collaboration.

2. Click Device settings.

3. Select the BBIM logging turned on checkbox.

4. Click Save.

5. In Windows services, restart the BlackBerry Collaboration Service.
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Troubleshooting the BlackBerry 
Collaboration Service

Enabling development-level logging for the 
BlackBerry Collaboration Service
You can configure advanced logging for the BlackBerry Collaboration Service using the rimpublic.property file to help you 
troubleshoot issues with the BlackBerry Collaboration Service. By default, the logging level for the BlackBerry Collaboration 
Service is DEBUG.

When you enable development-level logging, the log files display DEV. You can also increase the verbosity of the log files that are 
logged. For instructions on enabling development-level logging and increasing the verbosity of the log files, visit 
support.blackberry.com/kb to read article KB04939.

BlackBerry Collaboration Service starts and then 
stops when used with Microsoft Lync Server 
2010, Microsoft Lync Server 2013, or Skype for 
Business
Possible cause Possible solution

If the BBIM log file displays Error: No 
certificates were found matching 
the required criteria, then a valid 
certificate is not available in the Windows 
certificate keystore.

Install a new certificate. For more information about installing the required 
certificate, visit support.blackberry.com/kb to read article KB37126.

If the BBIM log file displays OCSConnector 
configuration complete with 
error=4, desc=Error: GRUU was not 
set in OCSConnector 

Complete the following tasks:

1. Manually provision the BlackBerry Collaboration Service as a trusted 
application and trusted application pool.
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Possible cause Possible solution

Terminating BCS process using 
command: net stop "BES - 
BlackBerry Collaboration Service", 
the BlackBerry Collaboration Service was not 
provisioned as a trusted application.

2. Add the gruu string to the rimpublic.property file. For more information 
about adding the gruu string to the rimpublic.property file, visit 
support.blackberry.com/kb to read article KB37115.

If the BBIM log file displays BlackBerry 
OCSConnector configuration 
timeout, the OCSConnector.exe process did 
not complete the required functions to start 
within the default 30-second timeout.

Increase the OCSConnector timeout in the rimpublic.property file. For more 
information, visit support.blackberry.com/kb to read article KB28399.

Related information
Manually provision the BlackBerry Collaboration Service as a trusted application using Lync PowerShell, on page 19
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Removing the BlackBerry 
Collaboration Service software

Steps to remove the BlackBerry Collaboration 
Service software
When you remove the BlackBerry Collaboration Service, you perform the following actions:

Step Action

Remove provisioning of the BlackBerry Collaboration Service as a trusted application and trusted 
application pool.

Remove the BlackBerry Collaboration Service software. 

Related information
Remove provisioning of the BlackBerry Collaboration Service as a trusted application and trusted pool, on page 41
Remove the BlackBerry Collaboration Service software, on page 42

Removing provisioning of the BlackBerry 
Collaboration Service as a trusted application 
and trusted application pool
You can use Windows PowerShell to remove the provisioning of the BlackBerry Collaboration Service as a trusted application 
software and trusted application pool before you remove BlackBerry Collaboration Service instances from your organization's 
network.

When you remove provisioning of the BlackBerry Collaboration Service as a trusted application, the provisioning record is 
removed from Microsoft Active Directory. When the provisioning record is removed from Microsoft Active Directory the 
BlackBerry Collaboration Service service remains running, but the communication to the Microsoft Lync Server or Skype for 
Business stops.
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Remove provisioning of the BlackBerry 
Collaboration Service as a trusted application 
and trusted pool
1. Log in to the computer that hosts Microsoft Lync Server 2010, Microsoft Lync Server 2013, or Skype for Business using an 

account with RTCUniversalServerAdmins group rights.

2. Open a Lync PowerShell window and complete the following steps:

a. To display the available SiteIDs in your organization's Microsoft Lync Server or Skype for Business environment, type 
Get-CsSite. Press Enter. Record the SiteIds.

b. To display the available Trusted Application Pools in your organization's Microsoft Lync Server or Skype for Business 
environment, type Get-CsTrustedApplicationPool. Press Enter. Record the available Trusted Application Pools.

c. To list the Computer GRUUs within a specific pool, type $a = Get-CsTrustedApplication -Identity "<YourPoolFQDN>/
urn:application:rimmsconnector". Press Enter.

Where YourPoolFQDN is the FQDN of the virtual Application pool of the BlackBerry Collaboration Service instances.

To view the FQDN and GRUU for each computer, type $a.ComputerGruus | fl. Record the Computer GRUU.

The following is an example of a ComputerGRUU: 
sip:<BlackBerryCollaborationServiceFQDN>@<domain_name>;gruu;opaque=srvr:rimmsconnector:<characters>.

d. Complete one of the following tasks:

• To remove one BlackBerry Collaboration Service instance from the trusted application pool when you have 
more than one BlackBerry Collaboration Service instance in your organization's environment, type 
Remove-CsTrustedApplicationComputer -Identity <BlackBerryCollaborationServiceFQDN>. Press Enter.

Repeat this step for each BlackBerry Collaboration Service instance in your organization's network.

• To remove the trusted application pool when you have only one BlackBerry Collaboration Service in your 
organization's network, type Remove-CsTrustedApplicationPool -Identity <YourPoolFQDN>. Press Enter.

e. To publish the change to the Microsoft Lync Server or Skype for Business environment, type Enable-CsTopology. 
Press Enter.

f. To verify that the trusted application pool is removed, type Get-CsTrustedApplication | ? 
{ $_.LegacyApplicationName -eq "RIMMSConnector" }.

g. To verify that the trusted applications are removed, type Get-CsTrustedApplicationPool.
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Removing the BlackBerry Collaboration Service 
software
You can use the uninstall application to remove the BlackBerry Collaboration Service software from a computer. The uninstall 
application can also remove the log files for the existing installation.

Remove the BlackBerry Collaboration Service 
software
1. On the taskbar, click Start > Control Panel.

2. Click Uninstall a program.

3. Click BlackBerry Collaboration Service.

4. Click Uninstall.

5. Optionally, select the You can select this option if you want the setup application to remove the log files for the existing 
installation check box.

6. Click Next.

7. Click Finish.

8. When the uninstall application prompts you to restart the computer to finish removing the BlackBerry Collaboration 
Service software, click OK.

9. Repeat steps 1 to 8 for each BlackBerry Collaboration Service instance.

After you finish: Send an updated device settings file to the BlackBerry 10 devices.

Related information
Sending updated device settings to BlackBerry 10 devices, on page 28
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Components used by the BlackBerry 
Collaboration Service

 

 

The architecture displays components used by the BlackBerry Collaboration Service in a BlackBerry UEM environment. For 
more information about the BlackBerry UEM architecture and the individual components, see the Architecture and data flows 
content.

Components Description

BlackBerry Collaboration Service The BlackBerry Collaboration Service provides a connection between your organization's 
instant messaging server and the BlackBerry Enterprise IM app on BlackBerry 10 devices 
running BlackBerry 10 OS version 10.2.1 or later.

BlackBerry UEM database The BlackBerry UEM database is a relational database that contains user account 
information and configuration information that the BlackBerry Collaboration Service and 
the BlackBerry UEM components use.

Management console The BlackBerry Collaboration Service console is integrated into the BlackBerry UEM 
management console. You can access it from the menu bar (Settings > Collaboration). 
The management console is used to manage the BlackBerry Collaboration Service and 
the user accounts and devices that are associated with BlackBerry UEM.
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Components Description

BlackBerry MDS Connection 
Service

The BlackBerry MDS Connection Service provides a secure connection between the 
BlackBerry 10 devices and the organizations's network. The connection is used when the 
device is not connected to your work Wi-Fi network.

The BlackBerry MDS Connection Service is also responsible for providing enterprise push 
services for BlackBerry 10 devices.

BlackBerry Affinity Manager The BlackBerry Affinity Manager maintains an SRP connection with the BlackBerry 
Infrastructure over the Internet.

BlackBerry Dispatcher The BlackBerry Dispatcher provides secure connectivity for BlackBerry 10 devices.

BlackBerry Router By default, BlackBerry UEM makes a direct connection to the BlackBerry Infrastructure 
over port 3101. The BlackBerry Router acts as a proxy server for connections over the 
BlackBerry Infrastructure between BlackBerry UEM and all devices.

TCP proxy If your organization already has a TCP proxy server installed or requires one to meet 
networking requirements, you can use a TCP proxy server instead of the BlackBerry 
Router.

Other components

Components Description

BlackBerry Infrastructure The BlackBerry Infrastructure validates SRP information and controls the data that travels 
outside your organization's firewall to and from your organization's devices.

Microsoft Active Directory If your organization uses Microsoft Active Directory, user account information is obtained 
from the Microsoft Active Directory. This information is required to create user accounts.

If your organization’s instant messaging server is Microsoft Lync Server 2010 or 2013, the 
BlackBerry Collaboration Service validates the user's login information with Microsoft 
Active Directory.

IBM Domino Directory If your organization uses IBM Sametime with the IBM Domino Directory, user account 
information is obtained from the IBM Domino Directory. The BlackBerry Collaboration 
Service validates the user's login information with the IBM Domino Directory.

Work Wi-Fi or VPN connection After a BlackBerry 10 device is activated on BlackBerry UEM, communication between 
the BlackBerry Collaboration Service and the BlackBerry 10 device can occur over your 
organization’s VPN or Wi-Fi network when the BlackBerry 10 device is within a wireless 
coverage area and enabled for access.

Instant messaging server Your organization requires one of the following instant messaging servers:
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Components Description

• IBM Sametime 8.5.2 or 9.0

• Microsoft Lync Server 2010, Microsoft Lync Server 2013, or Skype for Business

Data flow: Sending an instant message from the 
BlackBerry Enterprise IM app using Microsoft 
Lync Server or Skype for Business
 

 

1. A user logs in to the BlackBerry Enterprise IM app on a BlackBerry 10 device that is running BlackBerry 10 OS version 
10.2.1 or later in a Microsoft Lync Server environment or BlackBerry 10 OS version 10.3.1 or later in a Skype for Business 
environment.

2. The BlackBerry 10 device compresses and encrypts the user ID and password.

3. The BlackBerry Enterprise IM app performs one of the following actions:

• If the BlackBerry 10 device connects using the wireless network, the BlackBerry Enterprise IM app opens an SSL 
connection and sends the encrypted message through a secure channel from the BlackBerry 10 device through 
the BlackBerry Infrastructure, BlackBerry Router, BlackBerry Affinity Manager, to the BlackBerry Dispatcher 
over port 3101, through the BlackBerry MDS Connection Service, and to the BlackBerry Collaboration Service 
over port 8181.
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• If the BlackBerry 10 device connects using the work Wi-Fi network, the BlackBerry Enterprise IM app opens an 
SSL connection and sends the encrypted message from the BlackBerry 10 device to the BlackBerry 
Collaboration Service over port 8181.

4. The BlackBerry Collaboration Service checks the BlackBerry UEM database to find out if the maximum number of 
available sessions has been reached.

5. The BlackBerry Collaboration Service connects to Microsoft Active Directory to validate the user's login information.

6. The BlackBerry Collaboration Service connects to the instant messaging server and registers an active endpoint for the 
user using UCMA, over an MTLS connection over port 5061.

7. The instant messaging server sends the registration information back to the BlackBerry Collaboration Service.

8. The BlackBerry Collaboration Service performs one of the following actions:

• If the BlackBerry 10 device connects using the wireless network, the BlackBerry Collaboration Service sends the 
registration response to the BlackBerry 10 device using the SSL connection through the BlackBerry MDS 
Connection Service, BlackBerry Dispatcher, BlackBerry Affinity Manager, BlackBerry Router, and BlackBerry 
Infrastructure.

• If the BlackBerry 10 device connects using the work Wi-Fi network, the BlackBerry 10 device and the BlackBerry 
Collaboration Service use a direct connection over port 8181.

The session is created between the BlackBerry 10 device and the BlackBerry Collaboration Service and between the 
BlackBerry Collaboration Service and Microsoft Lync Server or Skype for Business server. The user can start a 
conversation, set an availability status, and so on.

Data flow: Sending an instant message from the 
BlackBerry Enterprise IM app using IBM 
Sametime
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1. A user logs in to the BlackBerry Enterprise IM app on a BlackBerry 10 device that is running BlackBerry 10 OS version 
10.2.1 or later.

2. The BlackBerry 10 device compresses and encrypts the user ID and password.

3. The Enterprise IM app performs one of the following actions:

• If the BlackBerry 10 device connects using the wireless network, the BlackBerry Enterprise IM app opens an SSL 
connection and sends the encrypted message through a secure channel from the BlackBerry 10 device through 
the BlackBerry Infrastructure, BlackBerry Router, BlackBerry Affinity Manager, to the BlackBerry Dispatcher 
over port 3101, through the BlackBerry MDS Connection Service, and to the BlackBerry Collaboration Service 
over port 8181.

• If the BlackBerry 10 device connects using the work Wi-Fi network, the BlackBerry Enterprise IM app opens an 
SSL connection on the BlackBerry 10 device and sends the encrypted message to the BlackBerry Collaboration 
Service over port 8181.

4. The BlackBerry Collaboration Service checks the BlackBerry UEM database to find out if the maximum number of 
available sessions has been reached.

5. The BlackBerry Collaboration Service signs the user in to the IBM Sametime server. The BlackBerry Collaboration Service 
starts an encrypted connection over TCP/IP using the IBM Sametime APIs, reformats the request from the BlackBerry 
proprietary protocol format into one that the IBM Sametime API supports, and sends the request. By default, the 
BlackBerry Collaboration Service starts the connection over port 1516 unless you specify a custom port number.

6. The IBM Sametime Server sends the acceptance back to the BlackBerry Collaboration Service.

7. The BlackBerry Collaboration Service performs one of the following actions:

• If the BlackBerry 10 device connects using the wireless network, the BlackBerry Collaboration Service sends the 
acceptance response to the BlackBerry 10 device through the BlackBerry MDS Connection Service, BlackBerry 
Dispatcher, BlackBerry Affinity Manager, BlackBerry Router, and BlackBerry Infrastructure.

• If the BlackBerry 10 device connects using the work Wi-Fi network, the BlackBerry 10 device and the BlackBerry 
Collaboration Service use a direct connection over port 8181.
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The session is created between the BlackBerry 10 device and the BlackBerry Collaboration Service and between the 
BlackBerry Collaboration Service and the IBM Sametime Server. The user can start a conversation, set an availability 
status, and so on.

Data flow: Sending an instant message from the 
BlackBerry Enterprise IM app when BlackBerry 
Secure Connect Plus is enabled
BlackBerry Enterprise IM app on BlackBerry 10 devices that have the BlackBerry Secure Connect Plus app installed and 
configured can connect to your organization's network using a secure IP tunnel through the BlackBerry Infrastructure.

BlackBerry Secure Connect Plus and the BlackBerry 10 device establishes a secure IP tunnel when it is the best available 
option for connecting to the organization’s network. If a BlackBerry 10 device is assigned a Wi-Fi profile and the device can 
access the work Wi-Fi network, the device uses this method to connect to the network. If the Wi-Fi network option is not 
available (for example, if the user is off-site and not in range of the work Wi-Fi network), then BlackBerry Secure Connect Plus 
and the device establish a secure IP tunnel.

 

 

1. A user logs in to the BlackBerry Enterprise IM app on a BlackBerry 10 device that is running BlackBerry 10 OS version 
10.3.2 or later.

2. The BlackBerry 10 device compresses and encrypts the user ID and password.

3. The BlackBerry UEM and BlackBerry 10 device determine that a secure IP tunnel is the best available method to connect 
the BlackBerry Enterprise IM app to the organization's network.

4. The BlackBerry 10 device sends a signal through a TLS tunnel, over port 443, to the BlackBerry Infrastructure to request a 
secure tunnel to the work network. The signal is encrypted by default using FIPS-140 certified Certicom libraries with 
cipher suites for RSA and ECC keys. The signaling tunnel is encrypted end-to-end.
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5. BlackBerry Secure Connect Plus receives the signal over port 3101 from the BlackBerry Infrastructure.

6. The BlackBerry 10 device and BlackBerry Secure Connect Plus negotiate the tunnel parameters and establish a secure 
tunnel over TURN through the BlackBerry Infrastructure. The tunnel is authenticated and encrypted end-to-end with 
DTLS.

7. The BlackBerry Enterprise IM app uses the tunnel to connect to the BlackBerry Collaboration Service using standard IPv4 
protocols (TCP and UDP).

8. If the BlackBerry 10 device connects using the wireless network, the BlackBerry Enterprise IM app opens an SSL 
connection and sends the encrypted message through a secure channel from the BlackBerry 10 device through the 
BlackBerry Infrastructure, BlackBerry Router, through the BlackBerry Secure Connect Plus, and to the BlackBerry 
Collaboration Service over port 8181

9. BlackBerry Secure Connect Plus transfers the IP data to and from your organization's network. BlackBerry Secure 
Connect Plus encrypts and decrypts traffic using FIPS-140 certified Certicom libraries.

10. The user can send and receive BlackBerry Enterprise IM messages on the device.

11. As long as the tunnel is open, BlackBerry Enterprise IM app can access network resources. When the tunnel is no longer 
the best available method to connect to your organization's network, such as the user is in range of the work Wi-Fi 
network, the BlackBerry Secure Connect Plus terminates the secure connection.

For more information about BlackBerry Secure Connect Plus, see the BlackBerry UEM Administration content.

Data flow: Authenticating the BlackBerry 
Enterprise IM app with the BlackBerry 
Collaboration Service when certificate-based 
authentication is enabled
The BlackBerry Collaboration Service is a trusted application server in the Microsoft Lync Server 2010, Microsoft Lync Server 
2013, and Skype for Business topology. The BlackBerry Collaboration Service authenticates the user with Microsoft Active 
Directory and signs the user in to Microsoft Lync Server or Skype for Business.

This data flow describes how the BlackBerry Enterprise IM app authenticates with the BlackBerry Collaboration Service when 
certificate-based authentication is enabled.
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1. You perform the following actions:

a Create a single sign-on profile.

b If necessary, rank the single sign-on profiles.

c Assign the single sign-on profile to user account or user group.

d Enable certificate-based authentication for the BlackBerry Collaboration Service.

e In Windows services, restart the BlackBerry Collaboration Service instance. If you have multiple instances of 
BlackBerry Collaboration Service, restart the BlackBerry Collaboration Service on each computer that hosts an 
instance of the BlackBerry Collaboration Service.

f Send an updated device settings file to the BlackBerry 10 devices.

2. The BlackBerry Collaboration Service retrieves the trusted root certificate and the intermediate trusted root certificate 
from BlackBerry UEM database and reads the maximum number of available sessions.

3. The user performs the following actions:

a Opens the BlackBerry Enterprise IM app.

b The BlackBerry Enterprise IM establishes a connection with the BlackBerry Collaboration Service.

4. The BlackBerry Collaboration Service performs the following tasks:

a Performs the MTLS authentication with the BlackBerry Enterprise IM app.

b Extracts the user's email address, associated with the BlackBerry 10 device, from the client certificate.

c Performs a SIP address lookup in Microsoft Active Directory using the user's email address.

d Store's the user's SIP address in a memory cache for eight hours to reduce Microsoft Active Directory lookups for 
subsequent logins.

e Connects to the Microsoft Lync Server or Skype for Business Server using the user's SIP address to register an active 
endpoint for the user using UCMA, over an MTLS connection over port 5061.

5. The instant messaging server sends the registration information to the BlackBerry Collaboration Service.
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6. The login process is complete and the user can start a conversation, set an availability status, and so on.
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Glossary

BES5 BlackBerry Enterprise Server 5

BES10 BlackBerry Enterprise Service 10

DMZ A demilitarized zone (DMZ) is a neutral subnetwork outside of an organization's firewall. It exists 
between the trusted LAN of the organization and the untrusted external wireless network and public 
Internet.

FQDN fully qualified domain name

GRUU globally routable user agent URI

HTTPS Hypertext Transfer Protocol over Secure Sockets Layer

MTLS Mutual Transport Layer Security

SIP Session Initiation Protocol

SRP Server Routing Protocol

SSL Secure Sockets Layer

TCP Transmission Control Protocol

TCP/IP Transmission Control Protocol/Internet Protocol (TCP/IP) is a set of communication protocols that is 
used to transmit data over networks, such as the Internet.

TLS Transport Layer Security

UMCA Microsoft Unified Communications Managed API

UTF-8 8-bit UCS/Unicode Transformation Format
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Legal notice

©2017 BlackBerry Limited. Trademarks, including but not limited to BLACKBERRY, BBM, BES, EMBLEM Design, ATHOC, 
MOVIRTU and SECUSMART are the trademarks or registered trademarks of BlackBerry Limited, its subsidiaries and/or 
affiliates, used under license, and the exclusive rights to such trademarks are expressly reserved. All other trademarks are the 
property of their respective owners.

IBM and Sametime are trademarks of International Business Machines Corporation, registered in many jurisdictions worldwide. 
Java is a trademark of Oracle and/or its affiliates. Microsoft, Active Directory, Hyper-V, Lync, SQL Server, Visual C++, Windows, 
and Windows Server are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries. Skype is a trademark of Skype Corporation. VMware is a registered trademark or trademark of VMware, Inc. in the 
United States and/or other jurisdictions. Wi-Fi is a trademark of the Wi-Fi Alliance. All other trademarks are the property of their 
respective owners.

This documentation including all documentation incorporated by reference herein such as documentation provided or made 
available on the BlackBerry website provided or made accessible "AS IS" and "AS AVAILABLE" and without condition, 
endorsement, guarantee, representation, or warranty of any kind by BlackBerry Limited and its affiliated companies 
("BlackBerry") and BlackBerry assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or 
omissions in this documentation. In order to protect BlackBerry proprietary and confidential information and/or trade secrets, 
this documentation may describe some aspects of BlackBerry technology in generalized terms. BlackBerry reserves the right to 
periodically change information that is contained in this documentation; however, BlackBerry makes no commitment to provide 
any such changes, updates, enhancements, or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or services 
including components and content such as content protected by copyright and/or third-party websites (collectively the "Third 
Party Products and Services"). BlackBerry does not control, and is not responsible for, any Third Party Products and Services 
including, without limitation the content, accuracy, copyright compliance, compatibility, performance, trustworthiness, legality, 
decency, links, or any other aspect of Third Party Products and Services. The inclusion of a reference to Third Party Products 
and Services in this documentation does not imply endorsement by BlackBerry of the Third Party Products and Services or the 
third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS, 
ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR WARRANTIES OF 
DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE QUALITY, NON-
INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING 
OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF 
ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE 
HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS MAY 
NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT PERMITTED BY 
LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO THE EXTENT THEY CANNOT BE 
EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU 
FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.
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TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL BLACKBERRY 
BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-
PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES 
REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, 
EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS 
OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR 
RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH BLACKBERRY 
PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF BLACKBERRY PRODUCTS OR SERVICES OR ANY 
PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR 
SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES WERE 
FORESEEN OR UNFORESEEN, AND EVEN IF BLACKBERRY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, BLACKBERRY SHALL HAVE NO 
OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY 
LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF THE 
CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE, 
TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH OR BREACHES 
OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED HEREIN; AND (B) 
TO BLACKBERRY AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING 
AIRTIME SERVICE PROVIDERS), AUTHORIZED BLACKBERRY DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE 
PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR, EMPLOYEE, 
AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF BLACKBERRY OR ANY AFFILIATES OF BLACKBERRY 
HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that your 
airtime service provider has agreed to support all of their features. Some airtime service providers might not offer Internet 
browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for availability, 
roaming arrangements, service plans and features. Installation or use of Third Party Products and Services with BlackBerry's 
products and services may require one or more patent, trademark, copyright, or other licenses in order to avoid infringement or 
violation of third party rights. You are solely responsible for determining whether to use Third Party Products and Services and if 
any third party licenses are required to do so. If required you are responsible for acquiring them. You should not install or use 
Third Party Products and Services until all necessary licenses have been acquired. Any Third Party Products and Services that 
are provided with BlackBerry's products and services are provided as a convenience to you and are provided "AS IS" with no 
express or implied conditions, endorsements, guarantees, representations, or warranties of any kind by BlackBerry and 
BlackBerry assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and Services shall be governed 
by and subject to you agreeing to the terms of separate licenses and other agreements applicable thereto with third parties, 
except to the extent expressly covered by a license or other agreement with BlackBerry.

The terms of use of any BlackBerry product or service are set out in a separate license or other agreement with BlackBerry 
applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN 
AGREEMENTS OR WARRANTIES PROVIDED BY BLACKBERRY FOR PORTIONS OF ANY BLACKBERRY PRODUCT OR SERVICE 
OTHER THAN THIS DOCUMENTATION.
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BlackBerry Enterprise Software incorporates certain third-party software. The license and copyright information associated with 
this software is available at http://worldwide.blackberry.com/legal/thirdpartysoftware.jsp.
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